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Introduction

AndreaMosaic est un logiciel qui crée des mosaiques photographiques (aussi
connues comme Photomosaic, un portmanteau de photos et mosaic, marque de
commerce de Runaway Technology, Inc.). Pour plus d’informations consulter la
page Wikipedia sur photographic mosaic.

Pour créer cette Mosaique vous avez besoin d’images qui constitueront les
carreaux et d’'une image a reproduire servant de guide pour la mosaique. Vous
pouvez ensuite utiliser les différents parametres du programme pour créer
différentes mosaiques.

v

v

v

v

Principales fonctionnalités d’AndreaMosaic

Outil professionnel pour la création de Mosaique de haute qualité
Interface claire et facile d’utilisation

Création automatique de variantes des images pour une Mosaique de
meilleure qualité

Recadrage Automatique des images au format de carreau choisi

Calcul sophistigué du rendu de la Mosaique avec compensation de
couleur intelligente pour une meilleure précision

Analyse élaborée des images

Optimisation de la sélection des carreaux afin de minimiser les
duplications

Supporte les vastes collections d’'images et les Mosaique de trés grande
taille

Extraction automatigue d'images a partir de séquence vidéo et création
de Mosaiques Vidéo

Quatre différents formats de carreaux: 1:1, 4:3, 16:9, 9:16, 3:2

Utilisation personnelle et commerciale gratuite

Mosaique a 49 carreau
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Images de Référence:

: [¥] [][=] [ ] ExiseadragoniMosaicioriginal imagesitest.fpg v

Résolution: 300 FPI M E:\Seadragon\Mosaic\Original imagestest Mosaique.jpg

Taille Carreaux: | 2000 carreaux ||
Duplication de Carreaux:

Duplication: | Iimité [x]

Espacement: | 3 Carreaux mini ||

Modif Couleur:

o [

x:
Miroir
Rotation 90°  [] Miroir Vertical

[] Rotation 180

pixel |v]
11974 % 1974 pixel

[_Création Mosaique | [ Options ][ Carreaux ][ AProposde | E=me (2]

Ecran principal d’ AndreaMosaic

Votre premiere Photo Mosaique

1. Créer une Liste d’'Images

Une liste d’'images est la liste de toutes les images qu’AndreaMosaic pourra
utiliser pour la création de votre Mosaique. Vous aurez besoin d’un répertoire
pour stocker ces images. Vous pouvez utiliser I'Explorateur Windows ou tout
autre programme a cet effet. Les images doivent étre au format JPG. C'est le
format le plus répandu chez les photographes. Vous pouvez aussi utiliser des
sous répertoires pour une meilleure organisation.

Il faut ensuite indiquer a AndreaMosaic ou se trouvent vos images. Le
programme analysera alors celles-ci, et le résultat sera stocké dans une Liste
d’'Images (extension .AMC). Ce fichier contient les informations de chaque
image (nom, taille, lieu).

00 Lancer AndreaMosaic

AndreaMosaic

(0 Dans la fenétre initiale, sélectionner un format de carreaux. Sur MacOS X
vous pouvez sélectionner I'image a reproduire par la Mosaique.

\ ArdreaMosaic

Carreaux Carrés (1:1) l [ Carreaux DSLR (3:2) }

—

—

Carreaux Rectangles (4:3) l [ Carreaux Film (16:9) }

l Tutorial }

Choisir un format de carreau ou le Tutorial pour plus
d’informations.

Fenétre initiale sous Windows/Linux
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80N

An ff:%reg Mos&ac

Original Image: Please select the Image that you want to us

o

¥

(" Selectimage.. )

Tile Aspect Ratio: @ Squares
O Rectangles (4:3)
O Rectangles (3:2)
(O Rectangles (16:9)

[6) Select Tiles ...

Fenétre initiale sous Mac OS X

00 Cliquer sur Images Carreaux. Dans la nouvelle fenétre qui s’ouvre vous
pouvez alors ajouter les répertoires ou se trouvent vos images a l'aide du
bouton Ajouter Repertmre ou en faisant glisser ceux-ci de I'Explorateur

Wmdows a la fenétre Répertoires.

Emplacement de la Liste d'Images:
Liste d'Images:

Ouvrir Liste J l Nouvelle Liste ] [ Sauver ] l Sauver Liste Sous... ]
;.Re'.per‘tuires Inclus tsélection en faisant g.Iisser ou avec Ajouter R‘.éper‘toire.] |v%
Répertoire ]
Répertoires:
[&d u | (2]

’ Ajouter Répertoire ] [ Supprimer Répertoire ] [ Extraction a partir de Vidéo ... ]

Noir & Blanc: []
Statut: Aucune Images sélectionnées. Merci d'ajouter un répertoire a la liste des répertoires Inclus

OK

00 Avec Ajouter Répertoire vous devez alors sélectionner un répertoire.
Seul les noms de répertoires sont visibles, pas les noms d’'images.
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Select Folder E]@
Cerca in: |['f}example "| Q ? i

e

ICDcars

Documerti [Dycities
recenti Chnature
— (Shother
F ICplanes
Deskiop Chtravel

=

Documenti
Risorse del
computer

g Faolder pame: | C:Mmozaichexample

Fisorse di rete _ | [ 2K ]

Annulla

00 Si vous désirez ajouter plusieurs répertoires, vous pouvez utiliser
I’Explorateur Windows et les faire glisser dans la fenétre Répertoires.

Emplacement de la Liste d'Images:

Liste d'Images: |

Ouvrir Liste J [ Nouvelle Liste J [ Sauver l [ Sauver Liste Sous... l
| Répertoires Inclus (sélection en faisant glisser ou avec Ajouter Répertoire) ltrj
Répertaire I

B C:\mosaic\example EEE
File Modifica  Visualizza Preferii Strumenti 2 -"ﬁk
Répertoires: Indirizza iﬁj Ct\mosaic\example V| Yai
Cartelle X MNome
E ) dex A | Diplanes
(23 elan
= 3 example
D art —
D cars k k
: [ cities Dcars gk it |
.L{J i ri:l nature m . hl
[ Ajouter Répertoire l [ Su 2 ather
- 1) plames 2
Noir & Blanc: [] < | & & | bd
Statut: Aucune Images sélectionnées. | 29gstt sslezionat: 4 3 Risorse del computer -lus

00 A partir de la liste déroulante située sous Ouvrir Liste vous pouvez
sélectionner “ Répertoires requis ” et “ Répertoires exclus ”. Répertoires
requis contient les images imposées. Trop d'images imposées risquent de
dégrader la Mosaique. Répertoires exclus sont les sous répertoires
d’'images que vous désirez exclure de la Liste d'Images.
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00 Apres avoir fini la sélection des répertoires, cliquer Sauver ou Sauver
Liste Sous.... AndreaMosaic analysera les images des répertoires et sous
répertoires sélectionnés. Vous devez attendre que le programme atteigne
100%. Vous pouvez annuler le processus en cliquant OK.

00 Quand le programme atteint 100% il demandera ou sauver la Liste
d’Images. Choisir un lieu et un nom. La création de la Liste d'Images est
terminée, vous pouvez retourner a la fenétre principale. Vous devez
seulement suivre ce processus la premiere fois. Dans le futur, simplement
charger la Liste d’'Images avec le bouton Ouvrir Liste....

Note: Si vous faites de quelconques modifications sur vos images (détruire,
déplacer, modifier, ajouter...) vous devez en informer AndreaMosaic en cliquant
le bouton Sauver . Lorsque vous cliguer ce bouton AndreaMosaic revérifiera
toutes les images et mettra a jour la Liste d'Images.

2. Définir les parametres de la Mosaique

Une fois la Liste d’Images créée (ou sélectionnée), il est nécessaire de définir
les différents parametres de création. Cependant pour votre premier test, vous
pouvez utiliser les valeurs par défaut. Par la suite apres avoir lu la section sur
les parametres d’AndreaMosaic vous pourrez expérimenter avec d’'autres
parametres.

3. Sélectionner I'image a reproduire
La troisieme étape est de sélectionner I'image a reproduire de la Mosaique. Le
programme générera une Mosaique représentant au mieux les détails de
I'image a reproduire.

1. Cliquer le bouton _| ou faites glisser une photo de I'Explorateur Windows
dans la fenétre d’ AndreaMosaic.

2. Si vous utilisez le _| choisissez votre image dans la fenétre qui s’ouvre.
Une fois sélectionnée cliquez sur Ouvrir. Si votre image n’est pas au
format JPG utilisez un programme pour la convertir.
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Cercain: |'{"'_')sarnple image Mosaic Vi Q ¥ E° -

&

Documenti

=N 1
|
- . o

=
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i
1%
&
=]
o

cumenti
Risorse del
computer MNome file:

Do

&L

Mosaic jpg A ; l Apri ]

‘-;‘] Tipo file: | Images JPEG {"jpa) | [ Anrulla ]
wrd [] &pri in sola lettura

Risorse di rete

Note: Vous pouvez sélectionner plusieurs images en recliquant ;' .Vous
pouvez aussi faire glisser plusieurs images de I'Explorateur a la fenétre
principale.

4., Création de la Mosaique
La derniere étape consiste a créer la Mosaique.

0 Cliguer Création Mosaique.

(0 Patience maintenant. Surtout si vous avez énormément d’images dans
votre Liste d’'Images (plus de 10,000) ou si vous avez un grand nombre de
carreaux (plus de 5000). En fonction de votre ordinateur, le processus
peut prendre des minutes ou des heures. Pendant celui-ci, vous pouvez
suivre le détail de la progression sous la ligne Statut :

Informations Mosaique: pixel ||

Image de référence : 1974 x 1974 pixel

Taille Mosaigue: 7071 x 7071 pixel = 50.0 MP
Taille Carreausx: 182 x 136 pixel = 24.8 KP

Mbre de Carreaux: 39 x 52 = 2085 carreaux (app
Epaisseur Contour: 0 pixel

Reésolution: 300 PPI

Taille Mosaique Maxi: 7071 pixel

Liste: 3835 images Horizontales

Liste: 1157 images Verticales

Statut:

SEENEE

’ Arrét Mosaique ‘ I Options ‘ ’ Images Carreaux ]

0 Une fois terminé, un message confirmera le succes de l'opération et
demandera si vous désirez ouvrir le répertoire ou se trouve la Mosaique.
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C'est un sous répertoire au nom et lieu de I'image a reproduire. Vous
pouvez aussi ouvrir ce répertoire en cliquant sur la ligne de texte bleu
sous la liste Image a reproduire par la Mosaique :

Image a reproduire par la Mosaique :

:[ﬂ E_&IE‘E”E:*.,Seadragonmriginal-images&test.jpg [1]

E:\Seadragon\Criginal-images\test Mosaigue.jpg
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Dans ce chapitre vous en apprendrez plus sur [linterface principale
d’AndreaMosaic et les parametres de création.

Dans le menu Start/Démarrez>Programs 2>AndreaMosaic vous trouverez quatre
versions différentes du programme. Leur seule différence est le format d’image
des carreaux de la Mosaigue. Choisissez la version appropriée au type d'images
présentes dans votre Liste d’Images. Celles-ci seront recadrées pour
correspondre exactement au format sélectionné.

Nom du Programme | Format Utiliser avec
AndreaMosaic 4:3 Images génériques
AndreaMosaic 16:9 Images au format cinéma
Cinescope
AndreaMosaic 3:2 Image au format de
DSLR/NTSC télévision américain ou
vidéo ou appareil DSLR
AndreaMosaic Square 1:1 Pour des carreaux carrés

Cette section vous permet de sauver I'ensemble des parametres de création de la

mosaique. Cliquer sur _| pour sauver les parametres courants. Sélectionner un
des éléments de la liste déroulante pour charger un jeu de parametres existant.

Cliquer sur L] pour détruire le jeu sélectionné. La liste déroulante contient des
jeux de parametres standards “(parquet)”, “(horizontal)” etc...pour des
réglages prédéfinis correspondant a certains types de Mosaique.

Vous pouvez transférer ces jeux de parametres sur un autre ordinateur en
copiant le fichier AndreaMosaicSettings*.txt situé dans le répertoire du
programme AndreaMosaic (généralement C:\Program Files\AndreaMosaic)

Composez ici la liste des images a reproduire. AndreaMosaic créera une
Mosaique pour chaque image dans cette liste, et sauvera ces derniére dans un
sous répertoire du répertoire de I'image a reproduire. Vous pouvez ajouter ou

retirer des images en utilisant les boutons _| _='| et _“l Vous pouvez aussi faire
glisser une ou plusieurs images de I'Explorateur Windows a la fenétre
principale.

Les parametres de taille décident de la dimension et de la résolution de la
Mosaique et de ses carreaux.

Taille Mosaique

Cette valeur spécifie la dimension globale de la Mosaique. Vous pouvez utiliser
n'importe quelle unité présente dans la liste déroulante: pixels, megapixels,

inch, feet, metre, cm. Des abréviations sont également disponibles : " pour
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pouce/inch, ' pour pied/feet, PX pour pixel, MP pour megapixel. La liste propose
des tailles standard mais vous pouvez spécifier vos propre tailles, par exemple:
38" ou 38 cm ou 38 MP. Cette valeur représentera le maximum de la plus
grande dimension (largeur/hauteur) de la Mosaique. Vous pouvez également
indiquer largeur et hauteur séparément: 50x40".

Cas particulier de la taille en pixels: Si vous spécifiez 5000 PX le maximum
largeur ou hauteur sera de 5000 pixels, mais si vous spécifiez 50 MP alors le
total largeur x hauteur sera de 50 megapixels.

Si vous désirez la taille maximum, indiquez 200 MP, cela créera la plus grande
Mosaique possible avec la version standard d’AndreaMosaic. Pour une taille
supérieure, vous avez besoin de la version professionnelle qui permet la
création de Mosaique jusqu'a 8000 megapixels (environ 30 pieds / 10 metre a
300 PPI ou 45 pieds / 15 metres a 200 PPI). Si cela n’est toujours pas suffisant,
contactez I'auteur d’AndreaMosaic.

Résolution

Ce parametre permet de choisir le nombre de pixels par pouce de votre
Mosaique. 300 PPI (pixels par pouce), la valeur par défaut, est élevée, et génere
90000 différents points de couleur par pouce carré, avec chaque point d’'une
couleur parmi 16 million.

Vous pouvez laisser la valeur par défaut, mais pour une Mosaique de grande
taille (5 pieds ou plus) je vous suggere de réduire la résolution a 200 PPI ou
moins, sinon il est fort probable que vous excederez la taille maximale de 200
megapixel de la version standard d’AndreaMosaic.

Taille Carreaux

Ce parametre vous permet de choisir le nombre de carreaux ou leur taille.
Comme pour la Mosaique, vous pouvez utiliser n'importe quelle unité, et utiliser
les abréviations. Je suggere de ne pas spécifier des carreaux d’une taille
inferieure a 1.5 cm / un demi pouce.

Vous pouvez également choisir de spécifier le nombre de carreaux (comme
2000 carreaux). Dans ce «cas, la taille des carreaux est déduite
automatiqguement. Vous pouvez voir les différentes tailles résultantes sous la
ligne Information Mosaique: et choisir I'unité pixels / inch / cm.

Informations Mosaiaue: pixel ||

PCE AL ENRLA R AL

Image de référence : 1974 x 1974 pixel

Taille Mosaique: 7071 x 7071 pixel = 50.0 MP
Taille Carreaux: 182 x 136 pixel = 24.8 KP

Mbre de Carreaux: 39 x 52 = 2085 carreaux (app
Epaisseur Contour: 0 pixel

Résolution: 300 PPI

Taille Mosaique Maxi: 7071 pixel

Liste: 3835 images Horizontales

Liste: 1157 images Verticales

I Arrét Mosaique ‘ I Options ‘ I Images Carreaux ]

Une autre possibilité consiste a spécifier le nombre de carreaux par rangée,
comme 50 carreaux x rangée. Dans ce cas, la zone Informations Mosaique:
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affichera la taille des carreaux et leur nombre total. Ces chiffres sont
approximatifs.

Les deux parametres de duplication définissent comment une méme image
peut étre utilisée plusieurs fois pour améliorer la qualité finale de la Mosaique.
La duplication est nécessaire si votre Liste d’'Images a moins d’'images que
votre Mosaique a de carreaux. Par exemple, si votre Liste contient 500 images
et vous créez une Mosaique de 2000 carreaux, vous devez autoriser une
duplication d’au moins 4 fois, sinon la Mosaique contiendra des carreaux noirs.
La duplication améliore aussi la qualité de la Mosaique. Il n'est par forcement
nécessaire de spécifier les deux parametres.

Duplication

Ceci défini le nombre de fois qu'une méme image peut étre utilisée comme
carreau. L'inconvénient étant que la méme image peut apparaitre plusieurs fois
de maniere consécutive dans les zones de méme couleur.

Espacement

Cette option permet de définir I'intervalle minimum entre deux duplications
d’image. Une valeur de “2 carreaux mini” signifie qu’il y aura au moins un
carreau entre deux duplications d’'une méme image. Les variantes d'une image
sont considérées come des duplications, ainsi que les variantes manuelles (voir
autres options). Noter que vous devez disposez de suffisamment d’images dans
votre Liste d’'Images. Une distance minimum de N carreaux requiert au moins
(N*2)2 images dans votre Liste d'Images, donc une distance de 5 carreaux
requiert au moins (5*2)?2 = 100 images dans la Liste d’'Images. Mais il vous en
faut sans doute plus.

Pour calculer la distance maximale utilisez la logique inverse. Avec une Liste
d’'Images de 500 images vous ne devriez pas utiliser plus de v500/2 = 7.

En bref, des valeurs élevées produisent une meilleure variété, mais une qualité
moindre. Je choisi en général le nombre le plus élevé en fonction de ma Liste
d’'images. Suggestion:

Images dans la Liste Espacement
Moins de 50 2

Entre 50 et 200 3

Entre 200 et 1000 4

Entre 2000 et 5000 10

Plus de 5000 images 15 ou plus

Motif permet de créer des Mosaiques dont les carreaux sont disposés
différemment. Leur sélection génere une visualisation de la grille sur I'image
affichée.

Les Motifs suivant sont disponibles :
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Motif Description

Standard | La mosaique sera composée uniguement de carreaux horizontaux. Si votre
Liste d'Images contient des carreaux verticaux, vous devez activer la
variante de carreaux : [x] Rotation 90° pour qu'’ils soient utilisés.

Vertical La mosaique sera composée uniquement de carreaux verticaux. Si votre
Liste d'Images contient des carreaux horizontaux, vous devez activer la
variante de carreaux : [x] Rotation 90° pour qu’ils soient utilisés.

Mixte La mosaique sera composée d’un mélange de carreaux verticaux et
horizontaux. Ceux-ci seront placés en rangées alternées. Les deux chiffres
indiquent le rapport entre images horizontales/carrées, et images verticales.
Par exemple « Mixte 3.8L 1P » signifie que pour chaque carreau vertical la
mosaigue contiendra 4 (3.8) carreaux horizontaux.

Parquet La mosaique sera composée d’'un mélange de carreaux verticaux et
horizontaux, ceux-ci composant un motif type parquet. Comme pour le
format Mixte, les deux chiffres indiquent le rapport entre images
horizontales/carrées, et images verticales.

Ce parametre défini dans quelle proportion la couleur de chaque carreau peut
étre modifiée afin de mieux correspondre a I'image a reproduire. Une valeur
élevée améliore la correspondance, mais chaque carreau sera différent de son
image d’origine. Une valeur trop élevée dégradera l'intégrité des carreaux. La
valeur « Aucune » garde les images de la Liste intactes. Dans Options ->
Modification de Couleur vous pouvez spécifiez le type de modification.

Une astuce qui améliore la qualité, est de permettre I'utilisation de variantes de
chaque image de la Liste, et AndreaMosaic fait cela automatiquement. Une
image peut ne pas correspondre exactement, mais une rotation de 180 degrés
peut améliorer les choses. Bien sur elle est alors a I’envers. A I'aide des cases a
cocher, vous pouvez définir quelles variantes sont autorisées. Vous devez en
sélectionner au moins une. Par default AndreaMosaic utilise miroir, rotation +/-
90 degrés et I'image originale. Ci-dessous les différentes variantes :
N

o—

Rotation 18092

Origina

Miroir - 4 f.d'
(horizontal) Miroir/Flip vertical R.-9092 +Miroir R.4+902 +Miroir
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Variantes de carreaux personnalisées

Vous pouvez créer vos propres variantes en utilisant Options - Calcul de la
Mosaique -2 Variantes de carreaux Perso. Vous devez ensuite choisir une image
pour chaque variante, et utiliser une convention de nom particuliere. Il n’est pas
nécessaire de fournir des variantes pour toutes les images.

Exemple: Vous voulez utiliser une rotation a 45 degrés, et une image recadrée
comme variantes de lI'image Lizard.jpg. Pour ce faire, simplement ajouter au
nom commun de chaque image, 3 soulignements suivis du nom de chaque
variante. Le résultat ressemblera alors a cela:

Lizard__Original.jpg Lizard___ Rotated45.jpg Lizard __ CroppedToEye.jpg

Normalement le mode Haute Qualité d’AndreaMosaic traiterait ces images
comme différentes. Avec le mode Variantes de carreaux Perso AndreaMosaic
considérera ces images comme des variantes de la méme image, au méme titre
gue miroir ou rotation, et leur appliquera les options de duplication comme
Duplication Espacement afin d’éviter leur placement contigu.

Notez que AndreaMosaic leur appliquera également les variantes standard
(miroir, rotation ...) ce qui dans ce cas produira un total de 3x8=24 variantes.

Cette zone récapitule les différentes informations sur la Mosaique. Taille finale,
nombre de carreaux, taille des carreaux, bordure etc. Vous pouvez choisir
I"'unité (Pixel, cm...). La ligne Liste donne le nombre d’images/vidéos au format
Vertical et Horizontal de votre liste d’'images. Cette information est tres utile
pour choisir le Motif le plus approprié. Si vous préférez ne pas autoriser la
rotation des images (Variantes de Carreaux: [ ] Rotation 90°), le choix d’un
motif dont le ratio entre Vertical et Horizontal est proche du ratio Vertical
Horizontal de votre Liste d’'image permettra d’optimiser I'utilisation de vos
Images.

Par exemple, si I’'on voie « Liste : 300 Images horizontales » et « Liste : 100
Images verticales », le motif le plus optimisé sera « Parquet (3H 1V) ». Cette
optimisation est sans importance si vous autorisez la rotation a 90° car chaque
image peut alors étre utilisée soit en vertical soit en horizontal.

Cette zone indique les messages sur les parametres ainsi que la progression du
calcul de la Mosaique.

Creation Pour lancer / stopper la création de la Mosaique

Mosaique

Options Accéder aux options avancées

Images Carreaux Sélectionner les images utilisables comme carreaux dans
la Mosaique

A Propos de Informations sur cette version d’AndreaMosaic

Ouvrir le manuel d’utilisation que vous lisez en ce
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moment
=" Vous permet de choisir le langage de l'interface
d’AndreaMosaic
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Dans ce chapitre vous apprendrez a créer une Liste d'Images, c'est-a-dire a
choisir les images utilisées a I'intérieur de vos Mosaiques.

| Liste d'Images: | C:\Mosaic\Example.amc

, Ouvrir Liste ] [ Nouvelle Liste ] l Sauver I l Sauver Liste Sous...
Répertoires Inclus (sélection en faisant glisser ou avec Ajouter Répertoire) v
. Répertaire

E:\Seadragon\Original-images\Library!,

Répertoires:

<l E

Ajouter Répertoire ‘ l Supprimer Répertoire J l Extraction a partir de Vidéo ...

Noir & Blanc: []
Statut: 3835 images Horizontales, 1157 images Verticales.

Fenétre de sélection des images carreaux

Vous pouvez créer une liste de répertoires contenant les images a utiliser a
I'aide des boutons Ajouter Répertoire / Supprimer Répertoire, ou en faisant
glisser ceux-ci de I'Explorateur Windows a la fenétre Répertoires. Vous pouvez
créer trois types de liste:

a. Répertoires inclus: Les images de ces répertoires seront utilisées si
elles conviennent.

b. Répertoires requis: Les images de «ces répertoires seront
impérativement utilisées. Dans certains cas cela peut nuire a la qualité de
la Mosaique.

c. Répertoires exclus: Les images de ces répertoires seront supprimées de
la liste des images disponibles. Il s'agit en général de sous répertoires de
ceux inclus.

Afficher la liste a modifier a l'aide de la liste déroulante. Utiliser Ajouter
Répertoire pour ajouter un répertoire dans la liste. Vous pouvez également y
faire glisser plusieurs répertoires a partir de I'Explorateur Windows. Ajouter un
fichier ajoutera tout le répertoire correspondant. Utiliser Supprimer
Répertoire pour enlever un répertoire de la liste.
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Les quatre boutons vous permettent de :

Ouvrir Liste Ouvrir une Liste existante préalablement sauvée avec le
bouton Sauver.

Nouvelle Liste Initialise la création d’'une Nouvelle Liste. Un répertoire
minimum est nécessaire.

Sauver Lance l'analyse des images au format JPG dans les
répertoires (et sous répertoires) des listes Répertoires
Inclus/Requis, a I|'exception des images de Ila liste
Répertoires Exclus. Une fois terminée, la liste est sauvée
dans un fichier Liste (extension .AMC).

Sauver Liste Méme chose que Sauver mais vous donne la possibilité de

Sous... spécifier un nom et lieu différent pour la Liste.

Une fois votre Liste d’'Images sauvée, vous pouvez fermer cette fenétre et

procéder a la création de votre Mosaique.

L’option Noir & Blanc vous permet de créer des Mosaiques noir et blanc sans
avoir besoin de convertir vos images. AndreaMosaic s’occupe de la modification
pendant le calcul, et ne modifiera pas vos images d’origine.

Une autre possibilité pour créer des mosaiques noir et blanc est d'utiliser vos
images couleurs, mais de choisir une image noir et blanc comme image a
reproduire. Utilisez ensuite le parametre Modif Couleur avec une valeur telle
gue 30%-40%. La Mosaique résultante sera composée d’images tres dé
saturées.

Lire le chapitre pour les instructions
concernant cette fonctionnalité.
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Fenétre d’options supplémentaires
Ce chap|tre vous explique les options supplémentaires d’AndreaMosaic: _

Parameétres de la Mosaique

Calcul de la Mosaique: |Haute qualité I

Comparaison d'Image: | Meilleure qualite v[
Détail Image: | Automatique

Modification de Couleur: _F‘rinrite’ Carreaux Haute [V;

Utiliser tous les carreaux:

-

Paramétres de sortie
e [ : |
Format de Fichier: |Bonne qualité (LJPG 80%) |"'i

Répertoire de la Mosaique: _-[Repertmre de I''mage de référence) lvr E}

|

Sous Répertoire de la Mosaique: :F’as de Sous Répertoire _!v!

d
Mosaique en page Web/HTML: | Pas de page Web IVi

Rapport Texte:

Deep Zoom Composer:

Subdiviser la Mosaique :

Création du Fichier Masque:

Nom de la Mosaique: Mouveau Hom

OO0 & |

Carreaux a partir de Film/Vidéo

Limitation d'images consécutives:  Aucune |vi
Contour Carreaux

Couleur: | Moir

Taille: . Pas de Contour

!
et e

Interface Utilisateur
Afficher les Bulles d’aide: [V]

OK ‘ ‘ Annuler H Paramétres avancés...

Fenétre d’options supplémentaires

Parametres de la Mosaique

Ces parametres affectent la facon dont la Mosaique est calculée, la génération /
correction des carreaux etc....

Calcul de la Mosaique
Cette option affecte comment les images sont sélectionnées:

Haute Option par défaut. Produit en général une meilleure Mosaique
Qualité au prix d'un peu plus d’utilisation mémoire.
Rapide Calcul plus rapide de sélection des meilleures images

possibles. Utilise moins de mémoire pour un peu moins de
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gualité. Avec les grandes Mosaiques il peut devenir plus lent.
Variantes de Basé sur Haute Qualité elle permet de spécifier vos propres
carreaux variantes. Si par exemple vous avez une série d’images
perso similaires a ne pas placer les unes a coté des autres. Voir les

parametres de variantes de carreaux pour plus d’information.

Comparaison d’'image

Cette option affecte la facon dont les images sont mises en correspondance
avec I'image a reproduire:

Meilleure Option par défaut. Produit les meilleurs résultats dans la
Qualité plupart des cas.

Plus Forte Evite les images avec de fortes différences

Plus Faible Autorise des images a fortes différences.

Détail image
Cette option détermine l'importance des détails dans la Mosaique. Le choix
optimal est Automatique:

Automatique Option par défaut. Produit les meilleurs résultats dans la
plupart des cas.
Pas de Détail Utilisez une de ces options si votre Liste d’lImages contient

Détail tres bas peu d’images (moins de 1000), ou si les détails ne sont pas
Détail Bas tres importants

Détail Moyen Choix équilibré

Détail Haut Utilisez une de ces options si votre Liste d'Images contient
Détail tres Haut beaucoup d’'images (plus de 10000).

Détail Maximum

Modification de couleur

Cette option précise le type de modification couleur appliquée aux images pour
une meilleure correspondance. Le taux est spécifié dans la fenétre principale.

Priorité Priorité aux carreaux d’'origine. Seul des changements globaux
Carreaux Haute sont effectués comme couleur tonalité ou luminance.

Priorité Priorité aux carreaux d’origines, mais avec possibles variations
Carreaux pour mieux correspondre aux détails de I'image a reproduire.
Moyenne

Equilibré Option par défaut, équilibre les types de modification couleur.
Priorité détails Permet une modification non uniforme limitée des carreaux
Moyenne pour se rapprocher des détails de I'image a reproduire.
Priorité détails Modification non uniforme des carreaux (tonalité, luminance,
Haute saturation, contraste) afin de se rapprocher au mieux de

I'image a reproduire au détriment de I'intégrité des carreaux.

Utiliser tous les carreaux

Sélection de cette option impose a AndreaMosaic d’utiliser toutes les images de
la Liste d'Images méme si certaines ne sont pas appropriées. Cette option ne
fonctionne que si la Liste contient moins d’images que la Mosaique de carreaux.
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Défini comment la Mosaigue est sauvée et quels formats sont générés.

Format de fichier

Choisir le format et la compression désirée. BMP est la plus haute qualité,
compression sans perte.

Répertoire de la Mosaique
Ce parametre vous permet de sauver la mosaique dans un autre répertoire que
celui de I'image a reproduire.

Sous Répertoire de la Mosaique

« Vous pouvez spécifier un sous répertoire pour chaque mosaique :

« Pas de sous répertoire : toutes les mosaigues seront sauvées dans le
répertoire mosaique.

« Créer un sous répertoire : un sous répertoire sera créé pour chague image

« NOUVEAU sous répertoire : un sous répertoire sera créer pour chague
image. Si vous exécutez le programme plusieurs fois avec la méme
image, un nouveau répertoire sera créé systématiquement.

Nom de la Mosaique
Vous permet de spécifier le nom de la mosaique créée.

Mosaique en page Web/Html
Génere une page Web de la Mosaique a la taille spécifiée.

Rapport Texte

Demande la génération d’un fichier texte contenant diverses informations sur la
Mosaique, et la liste des images utilisées.

Colonne Description

Position Coordonnées des carreaux en Pixels: gauche x haut.
Par exemple 100x600 signifie que le carreau démarre
100 pixel a partir de la gauche et 600 a partir du haut.

Image Nom de I'image du carreau.

Séquence Indexe du carreau dans la séquence. N'a de sens que
pour |'algorithme séquentiel.

Différence Différence entre le carreau et I'image a reproduire. Une

valeur faible indique un carreau proche de lI'image a
reproduire. En théorie 0 signifie une concordance
parfaite.

Nombre d'utilisation Nombre de fois ou I'image a été utilisée.

Deep Zoom Composer

Demande la génération d’'un projet Deep Zoom Composer Project que vous
pouvez ensuite publier sur internet en utilisant Deep Zoom Composer et
Silverlight™ de Microsoft. Cette option fonctionne aussi avec I'option Subdiviser
la Mosaique ci dessous.
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Subdiviser la Mosaique

Permet de subdiviser la Mosaique en une série d'images de résolution plus
faible. Au moment de lancer le calcul de la Mosaique, le programme vous
demandera de spécifier le nombre de subdivisions horizontales et verticales
dans une des trois unités proposées: pixels, carreaux/tiles ou colonnes/rangée.
Cette option est pratiqgue pour les Mosaiques de grande taille, telles que
supportées par la version professionnelle d’AndreaMosaic. Si votre Mosaique
dépasse les limites de taille du format utilisé, il vous sera propose d’utiliser

cette option ou de choisir les formats d'image PPM/RAW qui ne sont pas limités.
Largeur Hauteur Total
Taille en carreaux: 3% x |32 = | 2028
Taille en pixels: 7071 x | 7071 = | 49559641
[ Subdiviser la Mosaique Largeur Hauteur Total
Taille en carreaux: @ 38.85 x | 51.99 — | 2020.00
: Taille en pi)(ElS: 7071 x | 7071 = [ 49999041

Nbre de Subdivisions: 1 x |1 =1

0K | ‘ Annuler

Copie d’écran des Paramétres de subdivision

Note :

e Lorsque vous saisissez une valeur dans largeur ou hauteur, les autres
valeurs de la colonne sont mises a jour automatiquement.

« Si vous voulez que chaqgue subdivision ait une taille bien précise entrez la
valeur dans la ligne Taille en Pixel. Si vous voulez que toutes les
subdivisons aient exactement la méme taille, entrez une valeur dans
Nbre de Subdivisions.

» Sivous voulez une taille correspondant a une dimension en
pouce/pied/cm/m, vous devez la convertir en pixel en utilisant la valeur
PPI spécifiée dans Résolution. Si votre Résolution est 300 PPl alors 1 inch
= 300 pixels. 1 foot = 12 inch = 3600 pixels. 1 cm = 118.11 pixels. 1
metre = 11811 pixels.

Création du Fichier masque

Voir la section Mosaiques Irrégulieres afin de comprendre ce qu’est un
fichier masque. Cette option active la génération d’'un fichier masque (image
au suffixe MaskFile.jpg) qui contiendra le motif courant de la mosaique. Vous
pouvez alors éditer cette image pour la création de votre propre fichier masque
destine a la création d’une mosaique utilisant un fichier masque (option Fichier
Masque dans le Parametre de Taille)
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Limitation d’images consécutives: A n'utiliser que si vos images on été extraites
d’'un film, afin d’'éviter que des images similaires ne se retrouvent a coté les
unes des autres. Les images séparées par le chiffre indiqué sont considérées
comme étant les mémes. Utiliser ‘nnnn’ pour un nombre de votre choix.

Si votre Liste d’'Images a été générée a partir d'un film, elle contient sans doute
de nombreuses images similaires (Frames). Leurs noms sont dans le format
suivant:

MYMOVIE_FRAMESOO1\FRO0001.JPG

MYMOVIE_FRAMESO001\FR0O0002.JPG

MYMOVIE_FRAMESOO1\FR0O0003.JPG
Donc méme avec une valeur importante dans Duplication / Espacement, des
images similaires peuvent se retrouver dans une méme zone. Si cela se produit,
utiliser ce parametre. Une valeur de 5 signifie que deux images séparées par
moins de 4 images ne se retrouveront pas ensemble. Je vous suggeére
d’augmenter cette valeur progressivement jusqu'a obtenir I'effet désiré.

NOTE IMPORTANTE: Ce parametre n’est utilisé que pour les répertoires ou
fichier au nom contenant “FRAMES”. Vous pouvez donc mélanger images
normales et film dans une méme Liste d'Images.

Ce parametre vous permet de spécifier un contour pour vos carreaux. Cela
permet de mieux séparer les carreaux les uns des autres. Vous pouvez choisir
la couleur et I’épaisseur du contour (ave I'unité de votre choix : pixels, inch, cm,
etc.).
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Les films sont une bonne source d’'images pour une Mosaique car ils
contiennent énormément d’images, et une bonne Mosaique a besoin de
beaucoup d’'images.

1. Premiere étape - Trouver un film/vidéo

Trouvez un film/vidéo et I'importer au format AVI. Par exemple :
- Utiliser votre camera vidéo pour faire un film en vacances.

- Louer ou acheter une casette VHS ou un DVD.

- Télécharger un fichier film/vidéo/avi/divx sur Internet.

Télécharger quelqgue chose sur internet est probablement la solution la plus
simple. Pour importer une cassette il vous faut une carte de saisie vidéo sur
votre PC. Vous pouvez aussi extraire la vidéo d’'un DVD avec un programme
spécialisé (DVD Ripper) et la convertir en fichier vidéo (avis ou divx par
exemple).

Le seul impératif est que vous disposiez du codec approprié (VfW) afin de
pouvoir interpréter le fichier vidéo. Lire le chapitre « Support Vidéo dans
AndreaMosaic » pour plus de détails.

2. Deuxieme étape - Extraire les images du film

AndreaMosaic intégre un outil d’extraction d’image, mais vous pouvez utiliser
n'importe quel autre programme de fonctionnalité comparable.

Instructions:

1. Ouvrir la fenétre de sélection d’image avec le bouton Images Carreaux.

2. Cliquer sur Extraction a partir de Vidéo...

3. Sélectionner un fichier de type AVI/MPG/DIVX/XVID. Tout type de fichier
vidéo est acceptable si vous avez le bon codec.

4. Une fois sélectionné AndreaMosaic affiche les parametres d’extraction.
Choisir les valeurs appropriées, puis cliqguer sur Extraire. L’explication
des parametres se trouve dans la section suivante.

5. Le programme analysera le film, créera des sous répertoires d’'images la
ou se trouve le fichier, répertoires qui contiendront les images extraites.
Le programme ne détruit ni ne modifie aucun répertoire existant, donc
vous devez faire votre ménage si vous répétez le processus plusieurs fois.
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Parametres de la fenétre d’extraction

Taille / Position Image - Gauche/haut/Largeur/Hauteur :

Les quatre premiers parametres déterminent la taille de I'image. Normalement
les parametres par défaut sont bons, mais si le cadre blanc est plus grand que
I'image, vous pouvez réduire cette taille. Quand vous modifiez ces valeurs vous
devez cliquer sur Voir Cadre pour mettre a jour le cadre blanc. S’il n’y a pas
d’'image affichée, cliquez sur Aléatoire. Pour sélectionner une autre image du
fichier.

Images sélectionnées - Premiere/Derniéere:

Ces deux parametres vous permettent de choisir l'intervalle d’extraction. Par
défaut ils représentent la totalité du film. Vous pouvez entrer des valeurs
différentes pour supprimer le début ou la fin. Cliquer sur Premieére ou
Derniere pour afficher les limites sélectionnées.

Images sélectionnées - Compte:

Un film contient énormément d’images, mais la plus part sont similaires. En
pratiqgue on a donc seulement besoin d’une fraction d’ entre elles. Entrez ici le
nombre total d’'images a extraire. Je suggere un minimum de 5000 mais vous
pouvez aussi essayer 20,000. Plus d'images signifie une meilleure Mosaique.

Le programme extraira alors le nombre d'images demandées, espacées
régulierement sur la totalité du film pour avoir le moins de similarités possible.

Options - Désentrelacé:

Ne choisir cette option que si vous notez des lignes horizontales dans I'image.
Ceci se produit quand le film est enregistré avec une camera vidéo ou convertit
d’'une cassette VHS. Il est préférable d’'éviter cette option car elle diminue la
qualité d'image.

Options -Format de Fichier:
Si les images sont destinées a la création de Mosaigue, vous devez utiliser [x]
JPG Format. Le format BMP est seulement la pour votre utilisation personnelle.

Options - Qualité:

Ce parametre ne s’applique qu’'a la sortie JPG. Il détermine le taux de
compression. Plus la valeur est forte plus la taille image et sa qualité sont
grande. 50% est une bonne valeur, mais vous pouvez choisir plus ou moins.
Lors de la création de la mosaique, si les images sont réduites en taille une
gualité supérieure n’est pas nécessaire.

3. Troisieme étape - Analyzer les images

Une fois les images extraites, utilisez un navigateur d’'image pour les examiner.
Je suggere de supprimer les duplications ou les images sans intérét. Je passe
personnellement toutes les images en revues. Un bon navigateur d’'image vous
permet de visualiser une cinquantaine d’'images a la fois pour vous débarrasser
des mauvaises images. Créer ensuite une Liste d’'Images basée sur ces images
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Copie d'écran de la fenétre d'extraction sur un de mes films préférés:

Gauche: |0
Haut: |0
Largeur: | 608

Hauteur: 336

Auto H Max

Premiére: |0
Derniére: | 141683
Comte: | 5000
Format de [+ 1PG
Fichier: [] BMP
O

Qualité: |90

Préfixe: FR

L'extraction créera de nouveaux sous

répertoire nommés FRAMES001, Le Cadre blanc représente [image extraite. Modifier les valeurs Haut/Gauche/Taille et cliquer
FRAMESDNZ. Voir Cadre pour le mettre a jour.
Extraire | l Annuler I l Voir Cadre ‘ l 1 &re Image ‘ l Aléatoire H Derniére

Gauche: |0
Haut: |0
Largeur: | 608

Hauteur: 336

Auto H Max

Premiére: |0
Derniére: | 141683
Comte: | 5000
Format de [~ 1PG
Fichier: [ BMP
O

Qualité: |90

Préfixe: FR

L'extraction créera de nouveaux sous

répertoire nommés FRAMESO01, Le Cadre blanc représente I'image extraite. Modifier les valeurs Haut/Gauche/Taille et cliquer
FRAMESDOZ. Voir Cadre pour le mettre a jour.
Extraire | l Annuler I l Voir Cadre ‘ l 1 ére Image ‘ l Aléatoire H Derniére
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Support Vidéo dans AndreaMosaic

Le probléme le plus fréquent est avec I'ouverture d’un fichier AVI. AndreaMosaic utilise une
technologie ancienne (plus simple) appelée « Video for Windows » ou VfW. Elle nécessite
la présence d’'un codec compatible avec VfW. Cette fonctionnalité est disponible seulement
sous Windows.

1. Premiere étape - Identifier le Codec utilisé par votre vidéo

Télécharger et lancer le programme GSpot (http://en.wikipedia.org/wiki/GSpot). Y
charger votre vidéo et il vous indiquera tous les détails dont le codec utilisé.

Is‘ GSpot v2.70a: Kung Fu - 2%02 - Un verao amico EE®
File System Options Tables Help

Kl gﬁ}mr‘ ideo
R

File Codec D50 Mame |Divi 6.0.3 Fusion [T 2252
: 3 3| R
Path D:5Kung Fu - 280...n vero amico.avi

Status Codec(z) are Installed HEEY
Size|350 MB (358,616 KB / 367 223,296 :' Bl | 170 Foo 1uro
Test e [F=] ] joFEL | 170 5240
ﬂ = 57w Ha
FITETTETTETTET T [ ——=x==

B8] =1l max 5] 51037 avg / 300 ma

t
Len 471B120 Frms (70903 khp: 946 Qf|0.123

Picsds (20,000 Frames/s [25.000 Fields/z

FROG I/L TFF EBEFF FFF =:2 FAL HMTSC

ﬂ m H O = pic [w = 640« 480 seq ext Hiz 183

zar (1,333 (4:3)  par1.000(1:1)  dar [1.333 (4:3)

Audio i
Resizing = B of [owo [ cun]
Codec (020055 MPEG-1 Layer 3 3 = 1

Info | 48000Hz B0 kb/s tat . Steren
o =] [=] (=] Stat| Codecls] Installed

— Fropozed Codec Solutionz and Tests

GSpat MG [Src]-3 -] [Avi Splitter 1:--[B)-->[ffdshow Video Decoder 13 --[C)-» [Wideo Fenderer |
Wid Aud | A0 Wideo Render QK. Use [3] to play.

[Src]--r»-[A)->[&W] Splitter [»--[B]-->[ffdshow Video Decaoder 1»-{C]-»[video Renderer ]
J J J Wideo Render OK. Uze [3] to play.

Bl 2 | =
B 5] < »

2 Infg

Un autre logiciel possible est Medialnfo (http://mediainfo.sourceforge.net/):
. l-1edialnfo-l-1:\Butterﬁv.wmv M=
. File 7 View fgf Options i) Debug il Help . # Language
| IM\Conmwswone\Elutterﬂywmv jJ
“Container and general information )

Windows Media: 2 67 MiB, 10s 176ms
1video stream: VC-1 (WMV3)

Anudin s AN

Encoded date: UTC 2006-03-08 01:44:40.600

Comment: Courtesy of Robert Millis. Used by Permission
WhSharedUserRating: 99

WHICategory: Sample

rFirstvideo stream
1895 Kbps, 7207480 (1.500), at 29.970 fps, VC-1 (WMV3) (NTSC) (MP@ML} |
: Gotothe Wen site ot this vides codec ﬂ

rFirst audio stream
96.0 Kbps, 48.0 KHz, 2 channels, WMA (Version 2)
Goto the web site of this audio codec |

Eﬁﬂop;

Mote : for more information about this file, you must select a different view (Sheet, Tree...) —=
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2. Deuxieme étape - Installer le Codec

La deuxiéme étape consiste a trouver et installer le Codec approprié. Le logiciel K-Lite
Codec Pack contient plusieurs codec VfW comme on peut le voir dans la copie
d’écran ci dessous. Il supporte entre autre XVid/DivX. N’installez pas le pack
complet, mais seulement les codecs VfW comme indiqué ci dessous.

gl Setup - K-Lite Codec Pack M= E3 |

i
Select Components —

YWhich components should be installed? @

IEush:um Selection j
ﬁ Other filkers: ;I
. O Haali Videa Renderer
YEW video codecs:
- [] frdshow WP interface
LA wvid1.22
WPT
bty
LR R
O 4CM audio codecs:
- 0 MP3 [LAME) _
- O AC3ACH -

Current zelection requires at least 19.7 ME of disk space.

Help | < Back I Mest = I Cancel |

1. Télécharger la version ici http://www.codecguide.com/download_kl.htm

2. Lancer l'installation et cliquer sur Next/suivant jusqu'a la fenétre de
sélection des composants

Sélectionner Deselect All dans la liste déroulante.

Puis sélectionner seulement « VFW Video codecs ». Cliquer Next jusqu'a la
fin de I'installation.

P w

3. Troisieme étape - Convertir votre Vidéo

Si apreés l'installation des Codecs vous ne pouvez toujours pas ouvrir la vidéo, alors le bon
codec est toujours absent. Par exemple les formats Wmv de Microsoft ou MOV de
QuickTime ne sont pas supportés par VIW. Une solution alternative est alors de convertir
votre vidéo au format AVI avec le codec XVid.

1. Télécharger et installer le programme gratuit AviDemux
(http://www.videohelp.com/tools/AviDemux).

2. Ouvrir votre Vidéo et sélectionner le format de destination
Video Codec: MPEG-4 (Xvid)
Audio Codec: AC3
File Format: AVI
Vous pouvez ajouter certains traitements avec le bouton « Filters » comme réduire
la taille de la vidéo si vous prévoyez de l'utiliser pour des carreaux.
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EA greenpeace.wmv - Avidemunc
File Edit WView Video Audio Tools Go Auto Custom Help

H[=] B3

=6 E&0FE3r=Es

Video ‘
Configure
Filters. | .

Audio |
IMP3 {lame) VI :_
Configure |

Filters |
[ shift: |0 3: ms

Format

=l

QOOCIOLMEIE® GO W
Frame: [0 | /2187  Time: [00:00:00.000  /00:01:27.480

Frame Type: I(05) 00218?

000000 |

=

3. Add Job

Select File ->Add to Job List Insérer un nom de tache et de fichier de sauvegarde ici

C:\greenpeace.avi

B9 greenpeace.wmv - Avidemux
File Edit View Yideo Audio Tools

=] B3
Go Auto Custom Help

Ee= e [ EImOs
Recent Files Rl
Append... Cirl+Alt+A =
Save L
Close Cirl+w
G Information... Alt+Return
; Load/Run Project... [
& Save Project B3 save Job

g Save Project As...

Job name: | greenpeace

Output File: IC:\Qreenpea:E‘avi

Connect to avsproxy

Quit

!
L

QOGO LEIEOL GOV

1

—LGI

000000

B: 002157

Frame Type: 1(05)

}‘rame:lﬂ [2187 Time: |00:00:00.000  f00:01:27.980

4. View et Run Job
Select File ->View Job List Cliquer sur « Run All Jobs »
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Ed30bs

1 2 3

ﬂgreenpeace.js iReady 100:00:00 100:00:00 i
S OV U I

Run Selected Job
Delete Al Jobs

Delete Sel. Job

OK | Cancel

EEIE

Une fois terminé vous pouvez essayer d’ouvrir le résultat avec

AndreaMosaic, cela devrait fonctionner.

[ Encoding... HE
Phase: Encoding Processed Frames: 243
Video Codec:  Xvid Total Frames: 2138
Audio Codec: MP3 Quantiser: 4
Container: AVI Average Bitrate: 745 kB/s
Video Size: 0MB Elapsed: 00:00:15
Audio Size: 0oMB Time Remaining: 2 minutes
Total Size: 1MB Frames[sec: 15.28
1 11%
[ ishut down computer when ﬁnishedé Priority: |Below Mormal -
Pause [ Abort

La version gratuite d’AndreaMosaic possede les limitations suivantes:

Nombre maximum de pixels dans la Mosaique
finale

200 Megapixel

Nombre maximum de pixels dans la Mosaique
Vidéo

5 Megapixel

Nombre maximum de carreaux dans la

Mosaique

32,000
Carreaux

Nombre maximum d’'images dans la Liste

d’'Images

100,000 Images

Ceci étant, pour une faible donation au support de ce programme, vous pouvez

obtenir la version professionnelle dont les limites sont:

Nombre maximum de pixels dans la Mosaiques | 8,000

finale Megapixel
Nombre maximum de pixels dans la Mosaique | 100 Megapixel
Vidéo

Nombre maximum de carreaux dans la|500,000
Mosaigues Carreaux
Nombre maximum d’images dans la Liste|500,000 Images

d’'Images

Si méme ces limites sont trop faibles pour vous, contactez-moi personnellement

pour étudier votre cas particulier.
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Vous pouvez obtenir le Bonus Pack en apportant votre soutient a AndreaMosaic.
Celui-ci contient un certain nombre de motifs supplémentaires. Pour plus
d’'informations, visitez la page www.AndreaPlanet.com/andreamosaic/donation
Ou la page des Questions Fréguentes (FAQ)
www.AndreaPlanet.com/andreamosaic/faq.
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Mosaiques avec peu de carreaux

Je trouve que les Mosaiques les plus belles sont celles faites avec peu de
carreaux mais capable de bien reproduire I'image a reproduire. Ces mosaiques
sont en général composées de moins de 600 carreaux. Le principal probleme
consiste a disposer d'une « bonne » collection d’'images, ce qui nécessite un
trés grand nombre d’entre elles. J'utilise typiguement 20000 images de nature.

Comment créer une Mosaique a peu de carreaux:
1. Préparez une Liste d’'Images avec un grand nombre d’images.
2. Régler le parametre Taille Carreaux entre 100 carreaux et 600
carreaux. J'utilise entre 250 et 500.
3. Choisir une image de référence qui a peu de détails mais assez grand
avec des couleurs riches.

Quelques exemples:
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Lorsque j'ai créé ce programme, je voulais créer des Mosaiques irrégulieres.
Ceci est mon premier essai dans cette direction. Contactez-moi si vous avez des
guestions sur cette fonctionnalité.

Le Fichier Masque :

Vous devez tout d’abords créer un « Fichier Masque ». Il s’agit d’'une Image
dans laquelle chaque zone de couleur sera remplacée par une image de votre
Liste d’'Images. La taille/résolution du fichier masque définie la taille/résolution
de la mosaique finale (recadrée pour correspondre au rapport de I'image a
reproduire).

Il est important d’utiliser des couleurs uniformes (pas de dégradé) et de sauver
le fichier masque a la qualité Jpeg maximum.

Dans le Fichier Masque, deux couleurs ont une fonction particuliere pour
AndreaMosaic :

« Blanc : Les zones blanches seront considérées comme le fond d’image,
et donc aucunes images n’y seront insérées. Dans la mosaique finale, le
blanc sera remplacé par la couleur du contour spécifiée dans la fenétre
d’options supplémentaires. Le blanc peut donc étre utilisé pour créer des
contours ou des zones sans images.

« Noir : les zones noires seront fusionnées avec le carreau le plus proche.
Cette couleur peut donc étre utilisée pour délimiter les carreaux sans
générer de contour. Notez que les zones trop petites seront également
fusionnées avec le carreau le plus proche.

AndreaMosaic peut vous aider dans la création d’un fichier masque. Voir
I’explication du parametre Création du Fichier masque de la fenétre Options

Comment créer une Mosaique en utilisant un Fichier Masque ?

1. Dans le parametre Taille Mosaique, sélectionner Fichier Masque (en
bas de la liste). Les parametres Taille Carreaux, Motif et Options >
Contour Carreaux sont alors ignorés.

2. Quand vous cliguer le bouton de Création de la Mosaique, le programme
vous demandera de sélectionner un fichier Jpeg a utiliser comme Fichier
Masque. Exemples ci-dessous.
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Fichier Masque avec contours

Le fichier masque ci-dessous a été créé dans un logiciel de peinture en utilisant
une petite brosse blanche sur un fond uni bleu. D’apres les regles du fichier

masque, chague zone bleue délimitée correspondra a un carreau, et possédera
un contour de la couleur spécifiée dans le programme.

—

nches (le Blanc sera remplacé par la couleur du
contour)

/ S

LY

Détail du centre
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Utilisation avec “Teo” comme image de référence, et le contour noir par défaut.

a ¥y i
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Fichier Masque sans contours

Si I’'on remplace les lignes blanches du Fichier Masque précédent par des lignes
noires, la Mosaique résultante sera similaire, mais sans aucun contour.
"\, s : , A £ f y ’ y

- - < 3 )
i 7 = —
e VY

con
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7 P = i
Détail du centre (sans cont

<

Détail du cené san contours)

Le choix est affaire de gout. L’absence de contours offre un résultat plus
artistique, mais les contours aident a reconnaitre les différents carreaux.
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Détail du Fichier Masque avec lignes noires (les lignes noires disparaitront)

Fichier masque avec zones de couleurs

Il n"est pas nécessaires de dessiner les contours dans le fichier masque.
AndreaMosaic peut utiliser des zones de couleurs pour la définition des
carreaux. Dan I'exemple suivant, une série de polygones colorés sur fond blanc
(qui ne contiendra donc pas d’'images) suffisent.

L PR

Détail du Fichier Masque

Dans la Mosaique finale, le blanc sera remplacé par la couleur noire du contour
par défaut :
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" Détail de la M

. £

Foo “&n_ﬂr-?, " -. L u .
fond remplacée par I'image a reproduire

Cou)re_u; de

Le fond noir a été remplacé par I'image a reproduire a I'aide d’un logiciel de
peinture. Dans ces exemples, la mosaique a été construite avec une Liste
d’Images de seulement 500 images. Plus vous avez d’'images dans votre Liste
d’'Images, et meilleur sera le résultat.
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AndreaMosaic permet maintenant de créer des Mosaiques vidéo (non supporté sur Mac et
Linux). Le résultat final est une vidéo (fichier AVI) représentant une mosaique de I'image a
reproduire, mais ou chaque carreaux est une séquence vidéo au lieu d’'une image fixe..
Pour que cela soit possible, il faut évidemment que chaque clip vidéo utilisé pour un
carreau ait un contenu variant peu, afin qu’il puisse correspondre a cette zone de I'image a
reproduire.

Création des clips vidéo
Il faut tout d’abords créer un grand nombre de clips vidéo dont chaque contenu est
relativement stable lui permettant de reproduire une partie d'image fixe.

1. Choisir un film/vidéo et réduire sa taille a la taille approximative des carreaux de la
mosaique vidéo.(cela permettra de minimiser 'espace occupé par tous les clips
vidéo). Une mosaique Vidéo au format HD 720p contenant 250 carreaux aurait une
taille de carreaux de 60x40 pixels. Pou une mosaique au format HD 1080p la taille
des carreaux serait toujours en dessous de 100 pixels. Il est donc totalement inutile
d’extraire des clips vidéo a pleine résolution, cela serait une perte de temps et
d’espace. Vous avez besoin d'un éditeur vidéo pour changer la taille de votre
film/vidéo

2. Une fois que vous disposez de la vidéo a taille réduite, cliquez sur Images carreaux
->Extraction a partir de Vidéo. Choisir alors le fichier Vidéo (AVI) et si tout va bien la
fenétre Extraction a partir de Vidéo apparaitra. Pour extraire des clips Vidéos,
désélectionner [X] JPG et sélectionner [X] AVI. Cliquer sur Aléatoire et vérifier que le
cadre blanc est visible et bien centré. Vous pouvez changer sa taille et position avec
les boutons Auto, Max et les valeurs.

3. Cliguer ensuite sur Extraire. Le processus peut prendre un certain temps (plusieurs
heures) et AndreaMosaic ne [présentera aucun signe d’activité. Ne pas s’inquiéter et
laisser faire. Ce processus créera un répertoire la ou se trouve le fichier Vidéo,
contenant une série de clips vidéo. Il existe un certain nombre de paramétres
permettant de définir comment se fait I'extraction. Vous pouvez visualiser et éditer
ces parametres en cliquant the bouton AVI

Une fois I'extraction terminée vous devriez disposer d’un bon nombre de clips vidéo.
Répéter ce processus avec autan de film/vidéo que vous le désirez afin de constituer une
bonne collection de clips. Vous pouvez facilement obtenir plusieurs dizaine de milliers de
clips.

Création d’une Liste de Clips

Dans la fenétre Images carreaux
1. Créer une nouvelle Liste d’'Images (Clips) a utiliser comme carreaux
2. Sélectionner Répertoire Vidéo dans la liste déroulante des répertoires
3. Ajouter le(s) répertoire contenant les clips vidéo créés précédemment
4. Cliquer sur Sauver pour analyser et générer la Liste

Création d’une Photo Mosaique
Avant de générer la Mosaique Vidéo, il est préférable de commencer par générer une
Photo Mosaique. Celle-ci utilisera la premiére image des clips, et vous permettra de mettre
au point les différents parametres de la mosaique plus rapidement avant de calculer la
mosaique vidéo finale.

1. Dans la fenétre principale sélectionner 'image a reproduire

2. Dans Taille Mosaique choisissez une petite taille (correspondant a la taille de la

mosaique vidéo tels que « Vidéo HD 720p »)
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3. Dans Taille Carreaux sélectionner une valeur faible (enter 50 et 500). Rappelez
vous que la vidéo finale est en général de faible taille (1080p = 1920 x 1080) donc
un trop grand nombre de carreaux les rendrait tres petits.

4. Affiner les autres parameétres puis calculer la mosaique pour juger de I'aspect global.

Création de la Mosaique Vidéo

Pour passer de la création d’'une mosaique Photo a une Mosaique Vidéo, il vous suffit
d’aller dans la fenétre Options et de sélectionner « Mosaique Vidéo... » dans I'option
Format de Fichier. Vous pouvez choisir compressée (fichier plus petit) ou non
compresseée (plus rapide). Dans le cas du choix compressé, il vous faut sélectionner le
codec approprié disponible dans les Parameétres Avancés. Si vous n'avez pas de
probléme de place, je suggere de choisir non compressée, cela ira plus vite, et vous
pouvez toujours décider de compresser le fichier avec I'éditeur de votre choix apres coup.
Vous pouvez également sélectionner d’autres parametres tels que la longueur de la
mosaique vidéo dans Paramétres Avancés

Cette fenétre contient un ensemble de parameétres qu’un utilisateur typique n’a pas besoin
de modifier. Cette fenétre est accessible a partir de la fenétre Options, ainsi qu’a partir du
bouton AVI dans la fenétre d’Extraction a partir de Vidéo.. Chaque paramétre contient une
description, un choix de valeur, et la valeur systeme originale. Vous pouvez rendre les

permanent en utilisant Sauver les valeurs par défaut

Section

Options

Options

Options

Options

Options

Options

Comparaison d'Image
Comparaison d'Image
Comparaison d'Image
Comparaison d'Image
Mosaique Vidéo
Mosaique Vidéo
Mosaique Vidéo
Maosaique Vidéo
Mosaique Vidéo
Mosaique Vidéo
Extraire Vidéo
Extraire Vidéo
Extraire Vidéo
Extraire Vidéo
Extraire Vidéo
Extraire Vidéo

anements dans cette fenétre

Paramétre

Mombres de taches

Bloc mémoire

Priorité

Prévisualisation de la Mosa...
Chargement Liste de carre...
Sauvegarde Liste de carre...
Priorité Rouge

Priorité Vert

Priorité Bleu

Détail Moyen

Images Vidéo

Fréquence Vidéo

Mombre d'Images
Fréquence par défaut
Boucle avant arriére
FourCcC

Minirnum

Maximum

Seuil de Similarité

Seuil de vidéo statique
Minirmum statique

Vidéo statique

Valeur

= Options
0 Taches _—
200 MOct Nombres de taches : | 0 |¥| Taches
LOWEST
non T z —r
4 Exécution paralléle de certaines taches :

0 - Détection du nombre de processeurs
non Ll
10 1 - Utilisation d'un seul processeur
D° =0 - Utilisation du nombre spécifié de processeurs

: D“ -1 - Afficher la valeur du nombre de processeurs détectés.
1% Défaut systéme: 0 Taches .
-1%

MAX™2 Images
FREQ Images/Sec.
10 Images

10 Images/Sec.
ALL

0 Cedec

100 Images
600 Images
1500

150

50 Images

non

OK

T——

[ Lire valeurs par défaut

‘ lSauver les valeurs par défaut
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